Game Character Development with Maya

Antony Ward
I would like to dedicate this book firstly to my wife, Jade. Her continued support and understanding has been amazing, not just throughout the creation of this book but in the eight years we have been together.

The second dedication is to our children: Jacob, currently 18 months old, and our new baby who is growing as we speak and scheduled to make an appearance around January 2, 2005.

I love you all!
The actual idea of writing a book hadn’t even entered my mind until a friend of mine, Mat Buckland (author of *Programming Game AI By Example*), suggested I give it a go. So if it weren’t for a chance conversation with him, this book might never have been written.

Being a new author, I was a bit wary when I began this venture, but New Riders took me by the hand and guided me through the whole process, making it easy for me to concentrate on getting the information across to you readers.

Over the course of the book’s creation, I have worked with so many wonderful people—people who have shared my vision in creating a book for those who want to make great characters for games. So to all the people I haven’t mentioned here, you have not been forgotten, and thanks for your time and help.

My first contact with New Riders was with Elise Walter, whom I bugged constantly while my proposal was being scrutinized.

Next came my editors, Linda Harrison and then Kate McKinley. Both have been my guardian angels, going above and beyond to make this book the best it could be.

Technical editors Phelan Sykes, Charles Shami, and Jared Fry provided invaluable comments and advice. I have learned a lot from you all.

Toward the end of the process came copyeditor Carol Henry, who took each chapter and smoothed it out for me, ironing out all the creases and making it an easier read. Then Owen Wolfson went to heroic lengths to pull it all together and make it look like a book.

Finally, thank you, the reader, for buying this book. I hope you get as much out of reading it as I did writing it.
Contents At a Glance

Introduction ......................................................... xv
Chapter 1  Designing Your Character .......................... 1
Chapter 2  Modeling Kila ........................................... 25
Chapter 3  Finishing and Refining ................................. 89
Chapter 4  Modeling Details ........................................ 151
Chapter 5  Model Optimization .................................... 199
Chapter 6  Deformation Testing ................................. 239
Chapter 7  Modeling Grae ............................................ 269
Chapter 8  Texture Preparation .................................... 323
Chapter 9  Texture Painting ........................................ 391
Chapter 10 Levels of Detail (LODs) ............................ 443
Chapter 11 Skeleton Setup ........................................ 487
Chapter 12 Character Rigging .................................... 519
Chapter 13 Facial Animation Setup ............................ 603
Chapter 14 Final Character Deformation ...................... 651
Chapter 15 Finalize and Clean Up ............................. 693
Chapter 16 Animating for Games .............................. 709
Appendix A Normal Mapping in Maya ....................... 765
Appendix B Reference and Further Reading .................. 775
Index ................................................................. 781
# Table of Contents

Introduction .................................................. xv

## Chapter 1
Designing Your Character ................................. 1
What Makes a Successful Character? ..................... 2
The Three Stages of Concepting ............................ 4
Research ......................................................... 5
A Sample Character History ............................... 6
Technical Limitations ........................................ 11
Preparation ...................................................... 15
Design .......................................................... 16
Your Early Sketches ......................................... 19
Creating the Model Sheets ................................. 21
Summary ......................................................... 23

## Chapter 2
Modeling Kila .................................................. 25
Preparation ...................................................... 26
Artwork Storage ............................................... 26
Preparing the Work Environment .......................... 27
Getting Started in Maya .................................... 31
Maya’s Learning Movies and Tutorials .................. 31
Navigating with Menu Sets, Marking Menus, and The Hotbox ... 32
Setting up Maya Preferences ............................... 34
Importing to Maya ............................................. 37
Working with the Layer Editor ............................. 40
Building a Placeholder Character ......................... 41
Basic Limb Creation ......................................... 42
Create the Right Side ........................................ 47
Finishing the Head, Neck, and Torso ..................... 48
Cleaning Up .................................................... 49
The Basic Shape for Kila ..................................... 51
Limbs and Torso ............................................... 51
Stitching Together ............................................ 62
Head and Neck ................................................ 74
Feet and Hands ............................................... 81
Modeling the Ear .............................................. 168  
Attaching the Ear ............................................ 170  
Modeling the Eyes ............................................ 175  
Developing the Inner Mouth ................................. 177  
The Teeth ....................................................... 177  
The Tongue .................................................... 178  
Adding the Inner Mouth Elements ........................... 180  
The Inner Cheeks ............................................. 180  
Dressing Kila .................................................. 183  
Crop Top Details .............................................. 183  
Separating the Jeans from the Body .......................... 188  
Creating the Sash ............................................. 189  
Creating the Jeans ............................................ 190  
The Belt ......................................................... 195  
Summary ....................................................... 198  

Chapter 5  
Model Optimization ........................................... 199  
Deciding What to Remove .................................... 200  
Finding the Polygon Count .................................. 202  
Arm Optimization ............................................ 203  
Torso Optimization .......................................... 206  
Waist and Leg Optimization .................................. 208  
Foot Optimization ............................................ 213  
Hair, Face, and Neck Optimization ............................ 216  
The Hair ......................................................... 216  
The Face and Neck ............................................ 221  
Current Count .................................................. 229  
Hand Optimization ............................................ 230  
Final Check .................................................... 236  
Summary ....................................................... 238  

Chapter 6  
Deformation Testing .......................................... 239  
The Arms and Legs ............................................ 240  
Setting Up the Arm Skeleton .................................. 240  
Skeleton Binding .............................................. 243  
Painting Weights .............................................. 244  
Adding Polygons to the Elbow ................................. 251  
Shoulder Weight Painting and Testing ........................ 254
Table of Contents

Chapter 7

Modeling Grae .................................................. 269
The Torso and Limbs. ........................................... 270
Stitching Together .............................................. 273
Arm Position Adjustment .............................. 275
Creating Grae's Head. .............................. 276
Attaching the Head. .............................................. 277
Muscle Line Mapping ............................................. 278
The Chest, Shoulder, and Arm. .................. 278
The Torso ....................................................... 280
The Legs ......................................................... 281
Adding Details ..................................................... 283
Body Detail ....................................................... 284
Leg Detail ......................................................... 285
The Foot, with Three Toes and Claws. .......... 289
Creating Grae's Hands .............................. 292
Arm Detail ......................................................... 294
Giving Grae a Face .............................................. 297
Modeling the Wings ............................................. 300
Optimization ....................................................... 303
Head and Inner Mouth .............................. 304
Main Body and Legs ........................................... 305
Deformation Testing ............................................. 307
Joint Creation ..................................................... 307
Joint Renaming .................................................... 310
Binding and Testing ............................................ 311
Summary ........................................................... 321

Chapter 8

Texture Preparation ............................................ 323
Mapping Methods ............................................... 324
Dividing a Character ............................................ 327
Kila ............................................................... 327
Grae ............................................................... 335
Chapter 9

Texture Painting .................................................. 391
Image Preparation ............................................... 393
The Base Colors .................................................. 394
Viewing the Texture in Maya ............................. 396
Texture Alignment .................................................. 399
Lighter Shades and Highlights ......................... 401
Darker Shades and Shadows .............................. 404
Final Texture Details .......................................... 406
Face ................................................................. 406
Waist Area .......................................................... 408
Jeans Detail .......................................................... 408
Tattoo ............................................................... 411
Inner Mouth ........................................................ 411
Hair ................................................................. 413
Working with an Alpha Map ............................ 415
Creating the Hair Alpha Map ......................... 415
Viewing the Alpha Map in Maya ................. 417
Preparing the Eyes’ Alpha Map .................... 419
Creating the Eyes’ Alpha Map .................... 420
Creating the Eyelash Alpha Map .................... 422
Creating the Alpha Map for the Wings ........ 424
Bump and Specularity Maps ....................... 427
Grae’s Texture Effects ................................. 427
Kila’s Texture Effects ........................................ 432
Chapter 10

Levels of Detail (LODs) ........................................ 443
Why Do We Need LODs? ..................................... 444
Setting the Binding Pose .................................. 446
Arm Adjustment ............................................ 446
Finger Adjustment ......................................... 452
Generating LODs ............................................ 455
LOD 2: 3000 Polygons ...................................... 455
LOD 3: 1000 Polygons ...................................... 461
LOD 4: 500 Polygons ....................................... 474
LOD 5: 150 Polygons ....................................... 479
Grae’s LODs .................................................. 483
Testing LODs: The Level of Detail Group ................. 484
Summary ...................................................... 485

Chapter 11

Skeleton Setup .................................................. 487
The Base Skeletons .......................................... 488
Options for Joint Creation .................................. 488
Kila’s Skeletal Structure ..................................... 490
Grae’s Skeletal Structure .................................... 496
Additional Joints ............................................. 499
Eyes .......................................................... 499
Kila’s Chest .................................................. 500
Kila’s Hair .................................................... 502
Grae’s Wings ................................................ 503
Joint Cleanup ................................................ 505
Checking the Rotational Axis ............................... 505
Repositioning the Characters ............................... 516
Summary ...................................................... 517
# Table of Contents

## Chapter 12  Character Rigging

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Why Use Controls?</td>
<td>520</td>
</tr>
<tr>
<td>Icon Creation</td>
<td>522</td>
</tr>
<tr>
<td>Forward Kinematics and Inverse Kinematics</td>
<td>525</td>
</tr>
<tr>
<td>IK Solvers</td>
<td>527</td>
</tr>
<tr>
<td>Arm and Hand Controls</td>
<td>531</td>
</tr>
<tr>
<td>Arm Controls</td>
<td>531</td>
</tr>
<tr>
<td>Arm IK</td>
<td>535</td>
</tr>
<tr>
<td>Wrist Controls</td>
<td>538</td>
</tr>
<tr>
<td>Finger Controls</td>
<td>540</td>
</tr>
<tr>
<td>Leg and Feet Controls</td>
<td>550</td>
</tr>
<tr>
<td>Basic Control Feet for Kila</td>
<td>551</td>
</tr>
<tr>
<td>Additional Foot Controls for Kila</td>
<td>555</td>
</tr>
<tr>
<td>Basic Control Feet for Grae</td>
<td>565</td>
</tr>
<tr>
<td>Additional Foot Controls for Grae</td>
<td>566</td>
</tr>
<tr>
<td>Main Body Controls</td>
<td>571</td>
</tr>
<tr>
<td>Hips and Spine</td>
<td>571</td>
</tr>
<tr>
<td>Waist Control</td>
<td>575</td>
</tr>
<tr>
<td>Upper Body Controls</td>
<td>577</td>
</tr>
<tr>
<td>Clavicle</td>
<td>577</td>
</tr>
<tr>
<td>Neck</td>
<td>580</td>
</tr>
<tr>
<td>Head</td>
<td>581</td>
</tr>
<tr>
<td>More Controls</td>
<td>586</td>
</tr>
<tr>
<td>Eyes</td>
<td>586</td>
</tr>
<tr>
<td>Kila's Chest</td>
<td>588</td>
</tr>
<tr>
<td>Hair and Wings</td>
<td>589</td>
</tr>
<tr>
<td>Visibility Controllers</td>
<td>591</td>
</tr>
<tr>
<td>Color Coding for Icons</td>
<td>598</td>
</tr>
<tr>
<td>Summary</td>
<td>601</td>
</tr>
</tbody>
</table>

## Chapter 13  Facial Animation Setup

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joint-Based Facial Animation Setup (Kila)</td>
<td>604</td>
</tr>
<tr>
<td>Joint Placement</td>
<td>605</td>
</tr>
<tr>
<td>Preparation and Binding</td>
<td>608</td>
</tr>
<tr>
<td>Joint Weights</td>
<td>611</td>
</tr>
<tr>
<td>Facial Rig (Kila)</td>
<td>627</td>
</tr>
<tr>
<td>Rig Preparation</td>
<td>627</td>
</tr>
<tr>
<td>Rig Creation, Main Poses</td>
<td>629</td>
</tr>
<tr>
<td>Rig Creation, Mouth Shapes</td>
<td>631</td>
</tr>
<tr>
<td>Rig Creation, Eyebrows and Eyelids</td>
<td>633</td>
</tr>
</tbody>
</table>
## Table of Contents

### Chapter 14

**Final Character Deformation** 651  
Preparation and Binding 652  
Painting Kila’s Weights 654  
Arm Weights 654  
Hand Weights 664  
Leg and Waist Weights 667  
Head and Neck Weights 673  
Main Body Weights 676  
Mirroring Weights 681  
Hair Weights 682  
Final Rig Adjustments 685  
Level of Detail Weights 687  
Painting Grae’s Weights 691  
Summary 692

### Chapter 15

**Finalize and Clean Up** 693  
Scene Optimization 694  
Make Your Rig Idiot-Proof 696  
Character Sets 703  
Summary 707

### Chapter 16

**Animating for Games** 709  
Animation Optimization 710  
Mirroring Animations 711  
Dividing Animations 711  
Skeleton and Animation Sharing 711  
Animation Categories 712  
Idle and Fidget Animations 712  
Cycle Animations 712
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Four-Stage Animations</td>
<td>712</td>
</tr>
<tr>
<td>Blending Animations</td>
<td>713</td>
</tr>
<tr>
<td>Custom Animations</td>
<td>713</td>
</tr>
<tr>
<td>Cinematic Animations</td>
<td>713</td>
</tr>
<tr>
<td>The Animation List</td>
<td>714</td>
</tr>
<tr>
<td>Defining the Rest Pose</td>
<td>714</td>
</tr>
<tr>
<td>Animation Tools</td>
<td>716</td>
</tr>
<tr>
<td>Animation Controls</td>
<td>716</td>
</tr>
<tr>
<td>Setting Keyframes</td>
<td>718</td>
</tr>
<tr>
<td>The Graph Editor</td>
<td>719</td>
</tr>
<tr>
<td>Dope Sheet</td>
<td>724</td>
</tr>
<tr>
<td>Playblast</td>
<td>726</td>
</tr>
<tr>
<td>Creating a Walk Cycle</td>
<td>727</td>
</tr>
<tr>
<td>Scene Preparation</td>
<td>727</td>
</tr>
<tr>
<td>Legs and Waist: Blocking Out Poses</td>
<td>730</td>
</tr>
<tr>
<td>Legs and Waist: Refinement</td>
<td>736</td>
</tr>
<tr>
<td>Torso Animation</td>
<td>747</td>
</tr>
<tr>
<td>Arm and Clavicle Animation</td>
<td>752</td>
</tr>
<tr>
<td>Running in Place</td>
<td>759</td>
</tr>
<tr>
<td>Animation Archive</td>
<td>760</td>
</tr>
<tr>
<td>Summary</td>
<td>763</td>
</tr>
</tbody>
</table>

**Appendix A**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Mapping in Maya</td>
<td>765</td>
</tr>
<tr>
<td>System Requirements</td>
<td>766</td>
</tr>
<tr>
<td>Generating a Normal Map</td>
<td>766</td>
</tr>
<tr>
<td>Viewing Normal Maps</td>
<td>771</td>
</tr>
</tbody>
</table>

**Appendix B**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference and Further Reading</td>
<td>775</td>
</tr>
<tr>
<td>Anatomy Books</td>
<td>776</td>
</tr>
<tr>
<td>Animation Books</td>
<td>777</td>
</tr>
<tr>
<td>Web Sites.</td>
<td>777</td>
</tr>
<tr>
<td>Anatomy Reference</td>
<td>777</td>
</tr>
<tr>
<td>Miscellaneous References</td>
<td>778</td>
</tr>
<tr>
<td>Computer Graphics</td>
<td>779</td>
</tr>
<tr>
<td>Maya Sites</td>
<td>780</td>
</tr>
<tr>
<td>Graphics Tablets</td>
<td>780</td>
</tr>
</tbody>
</table>

Index ............................................................................. 781
Introduction

Every few years, another new game console or computer system is released that is more powerful than its predecessors. With this increase in power comes better graphics capabilities. This lifts the game artists’ restrictions, giving them freedom to add more detail to their geometry. But it also adds pressure to create yet more detailed and visually stunning characters, not only on paper but also in the game engine.

As the emphasis on graphics grows, so does the size of the development team needed to create a single game. Back in the early 1980s, a team comprised a single programmer who would no doubt create his or her own graphics—all that was needed were simple shapes formed from a few pixels on screen. Today’s gamers demand much more from their games and, as a result, team sizes can run into the hundreds.
With teams becoming so large, good organization is very important, and smaller subteams usually are formed to cover specific areas. On the art side, you will often have three primary teams: characters, environment, and animation. Possibly another, smaller team would cover the front end—the main startup menu, the onscreen display, and so on.

If you desire to join a character team, this book is just for you. As you work your way through each chapter, you will learn the processes of generating an in-game character, from concept to modeling, optimization, texturing, rigging, and finally animating. Along the way you’ll be introduced to the Maya interface and its many tools.

**Why Maya?**

“But why Maya?” I hear you ask. “Surely 3D Studio Max is the more dominant 3D application in the games industry.” There was a time when this was true, but Maya is fast becoming the industry standard.

In 2002 Maya was used to create six of the top ten best-selling PlayStation 2 titles. Characters in the Tomb Raider series, Jak and Daxter, Legend of Zelda, and Halo 2 have all been lovingly crafted using Maya’s extensive toolset. A recent Alias Systems press release states that in an independent survey performed by Acacia Research, 46 percent of North American games development studios said they used Maya. Within the top eight studios in Japan, 50 percent of their 3D software licenses are now Maya licenses.

All over the world, games development studios are turning to Maya. In North America, Infinity Ward, Ion Storm, Sony Computer Entertainment, Polyphony, Nintendo, Namco, and Square-Enix, to name but a few, have made the transition. In Europe, Digital Illusions, Blitz Games, Bizarre Creations, Lionhead Studios, and Electronic Arts all utilize Maya as the main tool for creating artwork for their games.

As you can see, more and more companies are switching to Maya, and this is mainly due to its continued focus on the games development market. This focus shows results—with each new release of Maya comes more features geared toward games development.
Why I Wrote This Book

Back when I started out in the games industry, there was nothing to refer to. You had only your own enthusiasm and desire to create interactive entertainment. In the run up to achieving my first position, I spent weeks working away on my Amiga 1200, drawing 2D graphics and creating animations for games I had designed myself. These graphics won me a position at a company called Freestyle Software, a place that gave me a chance and set my foot on the ladder of this industry.

There were no books or Web sites then about how to create games, so you had to be disciplined enough to teach yourself the latest 2D package or, as time went by, the current 3D package. Now there is a wealth of knowledge available, so getting into the industry is a little more difficult due to the intense competition. Today you have to prove you have a good understanding of the tasks involved in creating game-related artwork. Here in this book I’ll share some insider knowledge and techniques that will enable you to get a leg up into the games industry.

As the games market has grown over the years, the developer’s job has become more recognized as a true career path and not just a hobby. Universities now offer courses dedicated to games programming, artwork, and animation. But there is still a shortage of books on the subject. Plenty of books have been written about creating high-resolution characters for films, but only a scarce few cover the restrictions involved in working with game models, and there are none that cover creating console resolution models from concept through to animation.

Not everyone gets the opportunity to further his or her education formally; this is why I want to share what I’ve learned over the past eleven years. I am not saying that my methods are perfect, and there’s no requirement that you have to work this way. I’m simply showing you how I work. With that information, you can branch out and form your own, improved techniques.
About This Book

To the seasoned game artist, some of the structure of this book may be unexpected. Once you know the basic fundamentals of game character development, all the different stages tend to blur into just a few. When you know what to look out for early on—where polygons should be placed so the character deforms correctly, and so forth—you can preempt what would normally be done further down the line. I have tried to separate each step of the character development process into its own chapter, to help you, the reader, learn and understand each individual stage. Once you’ve worked through the book and gained some experience, you’ll find the boundaries of each section merging into a continuous process.

You may also wonder about the scope of the book; it covers a great deal. Those actually employed in the games industry tend to work in one specialized area, such as modeling, texturing, rigging, or animation. To date I have worked for five companies, and at each I have been called upon to perform a number of tasks. It’s sometimes just not economical to employ five people to cover five separate areas, when one or two can cover them all just as easily. From my experience, you are less likely to be offered a position if you are not flexible in your skills. Yes, specialize in one area if you like, such as character or game world development, but learn what you can about every stage. You will no doubt be called upon at some time to perform a task that’s not in your job description, so it’s helpful to have at least some of the relevant knowledge.

All that said, if you already have a development studio in your sights, it’s best to check out how they work so that you can focus your skills accordingly.
On the Included in the Lesson Files

Supplied with this book are downloadable Lesson Files that will work with both Windows and Mac systems. Throughout the book, keystrokes that are different on each platform are expressed in Windows/Mac format (for instance, Shift+Ctrl/Cmd).

The Lesson Files contain many tools and files associated with the book’s contents. There are four primary directories: Maya, Morgue, Project Files, and Software. The following sections describe these directories and give instructions for loading and setting them up.

**NOTE** The scripts available in the Maya/Scripts directory are free, shareware tools and are not necessary for working through this book. The shelf, however (found in Maya/Shelves), is an important part of the book’s projects and should be installed following the instructions below.

**Maya/Scripts/CreatureTools_v5**

Creature Tools is an automated character rigging and animation system for Maya. With Creature Tools installed, you will be able to generate a full skeleton and rig for your character in seconds.

Inside this directory you will find two subdirectories labeled Manual and Scripts. Place all the files found in the Scripts directory into your My Documents/maya/6.0/scripts folder (for Mac: {home}/Library/Preferences/Alias/maya/scripts). Replace the 6.0 in this path with the version number of Maya you are currently running; if you’re using the PLE included on the CD (described in “Software” just below), it’s 6.0PLE.

When you start Maya, you’ll see a new menu called Creature Tools; if it doesn’t appear, open the script editor and type `crToolsMenu` to load Creature Tools manually.

For information on how to use Creature Tools, refer to the manual found in the Manual directory.
**Maya/Scripts/Misc**

In this directory you will find a selection of scripts that I use regularly. To install these, simply place them into your My Documents/maya/6.0/scripts folder (for Mac: `{home}/Library/Preferences/Alias/maya/scripts`). Here again, you need to change the 6.0 in the path to match your Maya version.

To run the scripts, type the filename (without the .mel extension) into the script editor and press Enter.

- instanceSplit.mel converts instanced objects into unique ones.
- notePad.mel places a note into the current scene. When the scene is reloaded, notes are displayed to remind you or a colleague of anything you have put into the scene.
- showMaterial.mel is a handy little program that opens the Attribute Editor, displaying the material assigned to the selected face. This saves you the effort of searching through the Hypershade—a useful shortcut if your scene has hundreds of textures.
- resBatch.mel simply alters the way your textures are displayed in Maya’s views. It scales the size of all the textures, not physically but temporarily, speeding up the real-time display as you work.

**Maya/Shelves**

Please make sure you install this shelf (shelf_GCDM.mel) before you begin working with the projects in this book. It contains tools that are useful—and sometimes essential—for completing the example tasks.

Copy the shelf_GCDM.mel file into your My Documents/maya/6.0/prefs/shelves directory (for Mac: `{home}/Library/Preferences/Alias/maya/6.0/prefs/shelves`). A new Shelf called GCDM will be available the next time you launch Maya.

**Morgue**

In The Morgue you will find a selection of files taken straight from my own library. Feel free to use these to help develop your own skills and characters, but they are not available for commercial use.
**Project Files**
All of the Maya and texture files you will need for the book’s projects can be found in the Project Files directory. Each subdirectory name corresponds to the associated chapter number.

**Software**
You don’t actually need your own version of Maya to work through this book, because in the Lesson Files we have included the Personal Learning Edition (PLE), a free version of Maya. Although it is essentially the same application as the full version of Maya, the PLE does have some restrictions. For example, you can load the .mb files supplied on the CD, but you are only able to save them as .mp, meaning they will only work with the PLE.

Refer to Maya’s help directory found in Help > Maya Help (F1) for further details on the differences between the full and PLE versions of Maya.

If you would like to keep completely up to date with the PLE, you can download the absolutely latest version from the Alias Web site; you’ll find a link on the CD.

In addition, the Lesson Files contain a link to the Adobe Web site’s download page. Here you will find a demo version of Photoshop. Of course, if you already have a graphics program you’re comfortable with, feel free to use that.

Now that you know the where’s and why’s about this book and you have your environment set up, let’s move on and dive into the world of *Game Character Development with Maya.*
CHAPTER 4
Modeling Details

WE ARE REALLY moving along with Kila—the end is in sight. In this chapter we will give our character’s head some important details: hair, eyes, ears, and the inner mouth. Then we will work on her clothing, adding her crop-top T-shirt, and complementing the jeans with a sash and belt.

CD Files
Kila_Feet.mb
Kila_Hair.mb
Kila_Ear_01.mb
Kila_Ear_02.mb
Kila_InnerMouth.mb
Kila_Head.mb
Kila_Complete.mb
KilaFront.jpg
KilaSide.jpg
KilaFaceFront.jpg
KilaFaceSide.jpg
Creating Hair

You are probably looking at your character and thinking, “She doesn’t look much like what she’s supposed to…” Her lack of hair is the main reason for Kila’s unexciting appearance right now; you will be surprised at how much interest a hairdo adds to a character’s overall look.

Let’s start work on giving Kila some hair, by first loading the file you last worked on, Kila_Feet.mb. Look at the original concept artwork, or the image planes, and you’ll see that her hair is not fully symmetrical, so we will, to an extent, need to model the whole coiffure. Her hair is parted down the center, so what we can do is model one-half of the hairdo, then duplicate and mirror it, and edit the copy to have the slightly different look of the other half.

To begin, let’s remove some of the polygons from around the back of the head, the ones that will not be seen. Using Figure 4.1 as a guide, mark in the hairline using the Split Polygon tool, and then delete the unwanted polygons.

**NOTE**: You will only need to work on one side of the model as the other is merely a mirrored instance.

![Figure 4.1](image) Mark the hairline and then remove the polygons from the back of the head.

We are finished editing the main model now. Carving in the hairline gives us a starting point for creating the hair. We’ll begin with the inner layer—the hair lying closest to her face and head.
Inner Layer
We want the hair to look layered, giving it some depth. To create this effect, we will use strips of polygons starting at the hairline and building our way out.

1. Create a new polygonal plane like the one seen in Figure 4.2, by going to Create > Polygon Primitives > Plane and opening up the options window. Set the configuration to Width 0.02, Height 0.15, Subdivisions Along Width 1, and Subdivisions Along Height 5.

![Figure 4.2 Create a new polygonal plane.](image)

2. Move the new plane, matching it up to the polygons on the side of the head as shown in Figure 4.3. Duplicate the plane and position the new copy next to the original while trying to stay between the two vertices on the head, so the width of the strip matches the width of the polygon underneath it.

![Figure 4.3 Position the planes to create the bottom layer of her hair.](image)
3. Continue duplicating and positioning strips until you have five of them placed around the head. Remember, we are only working on half of the head for now, so don’t place the strips all the way around.

We now have our innermost strips for the hair; next we will create the outer layer that starts at the top of her head and drapes over the inner layer of hair. With these two areas in place, we can create other strips to place in between, amplifying the layered effect we are after.

**Outer Layer**

Start work on the outermost layer of hair.

1. Duplicate one of the current strips, position it at the top of the head, and rotate it by 90 degrees (Figure 4.4). Make sure the top of the strip lies at the same position as the center of the model; this point will act as the part in her hair.

   ![Figure 4.4](image)
   
   **Figure 4.4** Add a new plane above the head and curve it to follow the shape of the head.

2. Edit this strip, bending it to follow the shape of her head. You will notice in Figure 4.4 that the strip is too short. It does need to be longer, so select the edge nearest the bottom and use the Extrude Edge tool to add three more divisions.
As demonstrated in Figure 4.5, duplicate the new strip several times, until you have filled out the top, side, and back of the left side of her head.

Looking from the side, the hair seems very flat. Manipulate each strip individually, altering the position and scale to make the hair higher at the crown than in the front (Figure 4.6).

Time to do a bit of tidying up. In the perspective view, look down onto your hair geometry; it should look like mine in the left panel of Figure 4.7—a bit of a mess. Before moving on, combine the upper parts of the strips and weld some of the vertices around the top, trying for the result shown on the right in Figure 4.7. Don’t work all the way down the strips; just concentrate on the top five rows of vertices for now.
We now have the base geometry in place for the top of her hair. Create a mirrored instance to use as reference, and you’ll see something like Figure 4.8 (left). Take some time now to work on the shape a little more. It may help to snap the vertices together between the strips, but do not weld them yet. Aim for something like Figure 4.8 (right).
The Front Hairline

Let’s now create the front hairline, filling in the gap between her forehead and hair. Remove the mirrored instance of the hair for now so we can concentrate on just one side.

1. First, hide the top layer of hair by selecting it and pressing Ctrl+H/Cmd+H. Leave the underneath visible because you will need it for this part of the modeling.

2. Duplicate one of the side strips and position it above her forehead, following the example in the middle panel of Figure 4.9.

3. Adjust the vertices until you have the arrangement shown in the right panel of Figure 4.9, snapping the lower vertices to the ones on the top of her forehead.

4. Bring back the geometry that makes up the top of her hair by pressing Ctrl+Shift+H/Cmd+Shift+H. Now snap the upper vertices of this newly added forehead strip to the front section of her hair (Figure 4.10).
Now combine both pieces of geometry—the hairline strip and the front parts of her hair—and weld the vertices at the front, making a single, solid object.

To complete the front hairline area, you need to hide the rest of the model, making just the hair visible. This time, instead of selecting all the geometry and pressing Ctrl+H/Cmd+H to hide it, we can simply isolate the hair.

To do this, select the upper piece of hair and go to the Show menu of the active view. Move down to Isolate Selected, and choose View Selected. You should now be presented with just the top layer of hair, as shown in the left panel of Figure 4.11.

The Isolate Select command is very useful. For example, you can isolate components such as a selection of faces rather than whole objects.

Continuing on, you need to extrude the lower edge at the temple (Figure 4.11, middle). This edge must be brought down to meet the bottom of her hair (Figure 4.11, right).
Weld the side vertices of the extrusion to the first row of vertices closest to them on the existing hair, and then adjust the vertices to create a better shape (Figure 4.12).

Adding Volume to the Hair

Un-isolate the geometry so you can see the face and head again. You do this exactly the same way as you did earlier to isolate it: Choose Show > Isolate Select > View Selected, so that it is unchecked.

Now we will give the outer layer of hair some more shape, getting rid of the dome it currently resembles. After that, we’ll work on the rest of the hair, filling it out and thickening it to give it more volume.
1 As shown in Figure 4.13 on the left, select the bottom row of edges and collapse them.

Because you did not weld the vertices on the lower areas of the strips, when you collapse the edges they will form spikes as illustrated on the right in Figure 4.13.

2 Move up to the next row of edges and, editing each one in turn, scale them in slightly. Do this for the next row, too, until you have long spikes running around her hair, as shown in Figure 4.14.
Apart from some final tweaking, our outer layer is complete. It needs additional work, moving the vertices to randomize the shape, but we won’t do that until all the basic geometry is in place. Now we must fill out the hair, making it appear thicker, giving it more volume.

3 Using the strips on the inside layer, do as you did with the outer ones. Select the bottom edges and collapse them, then adjust the upper edges until you have long, sharp polygons.

4 Duplicate these edited inner strips, creating a total of 17, and position them between the outer layer and the head.

When you’re finished working on this side of the head, you can create a mirrored version to see how the hair is looking overall. Begin by selecting all the pieces of geometry that make up the hair on Kila’s left side. Press Ctrl+G/Cmd+G to group them. Open up the Duplicate options, make sure that Instance is not selected, and click Duplicate or Apply to create a mirrored duplicate of the group (setting the Scale value for the X-axis to -1).

Kila’s coiffure should now resemble Figure 4.15. For now, the hair shape is acceptable. It still needs more work, but let’s leave it for now and go on to create the left side of the hairdo (Kila’s right). It will be different from the right side.
**Developing the Left Side**

The hair on Kila’s right side hangs down, but on the other side the hair is tucked behind the left ear. To start developing this side of the hairdo, first hide the inner strips so you can concentrate on the outer layer of hair (**Figure 4.16**).

![Figure 4.16 Prepare the hair for more work by hiding the inner layer on Kila’s left.](image1)

1. Select the vertices shown in **Figure 4.17b**, and weld them all together until you are left with a single vertex (**Figure 4.17c**).

![Figure 4.17 The steps for tucking the hair behind the ear](image2)

2. Move this remaining vertex up to roughly the spot where the top of the ear should be. Then proceed to work on refining this area of the hairdo until the tucked-in look is correct (**Figure 4.17d**).

3. Combine both the left and right sides that make up the top, outer layer of her hairdo.
4 Bring back the inner-layer strips you hid earlier, adjusting them to fit the new tucked-in arrangement. You will have to delete some of the strips that no longer fit the shape.

At this point, you have basic geometry in place to use for Kila’s hair. Keep working on it until you are happy with the overall shape.

**Organizing the Strips**

To keep things in order, we will now organize the strips used to fill in the hair, combining them into individual horseshoe-shaped layers. In this arrangement, not only will they be easier to work on, but applying a texture to them will be less difficult.

1 Hide everything except the strips of hair (**Figure 4.18**).

2 Switch to the top view so you are looking down on the strips (**Figure 4.19**, left). It looks like I got a bit carried away, rotating the strips to fit. First, using the Rotate manipulator, alter the rotations so the strips appear as flat lines in the top view. You will find that the same axis needs altering for each strip.
We want to move the strips so they follow a more organized structure.

3 Position all the strips so they follow a curve, making three concentric curves in total. Add more strips if you need them to complete the curves.

4 Combine the strips that make up each curve so that you end up with three separate horseshoe-shaped objects (Figure 4.19, right).

5 Switch to the perspective view and isolate the outermost section of hair. All you should be able to see is that particular piece of the geometry (Figure 4.20, left).

Level off the top and adjust the vertices to tidy up the geometry.
6 Scale the top row of vertices down the Y axis so that they all lie on the same level. Just using the basic Scale manipulator is sufficient here because you do not need to have an exact scale. Then weld them all together, making a complete strip running around the top. Do this again for the next row down. As needed, adjust the remaining strips to tidy up the rest of the geometry. Figure 4.20 (right) shows what you’re aiming for.

7 Repeat these welding steps for the other two, inner layers until you have something close to what’s shown in Figure 4.21.

Now unhide the rest of Kila to see how things are looking. As you can see in Figure 4.22, I’ve started to shape the outer hair somewhat, by curling the ends up very slightly and refining the overall shape. Notice that I have added another strip for a loose strand at the right temple.
Refining the Hair
To complete Kila’s hair we will now spend some time working on the inner-layer strips, bending the bottoms out to follow the strands in the outer layer. We’ll also add some more volume by twisting the strips at the bottom.

Because we have been working in layers, the first step is easy. On the first inner layer, select the lower row of vertices and globally scale them outward. Move up to the next row and do the same. Continue this process on the other inner rows, curling the hair slightly outward at the bottom.

To fill the hair out a little and thicken it up, we now need to twist each strip slightly, like turning the slats of a venetian blind.

1. Select every other edge on each strip (Figure 4.23, left and middle). Then scale them across the X and Y axes, bringing them in toward the middle as shown in Figure 4.23 (right). Select only the bottom two edges of each strip; do not scale the top.

2. Repeat this process on the next layer, this time selecting the opposite edges so that the effect will be reversed.

3. Finally, scale the third layer in the same way as the first.

All the refinement work left to do now is to work on the overall shape, trying to fill in any large gaps between the strands of her hair. Take a look at Figure 4.24 to see an example of the end result.
For now, do not combine all the elements that make up the hair. Just clean up the scene and save your work as Kila_Hair.mb.

**Quick Cleanup with the Outliner**

If you open up your Outliner, you may notice that a lot of groups and empty nodes are starting to appear; you can also see these in Figure 4.25a. Most of these elements are unnecessary and only bump up the file size. Let’s clean them up.
1 Start by selecting in the Perspective view all the pieces of geometry you want to keep, and press Ctrl+G/Cmd+G to put them into a group. Figure 4.25b shows the new group named group3.

TIP The easiest way to select what you want to keep is to drag a selection lasso over all of the geometry in the view.

2 In the Outliner, click and hold the middle mouse button on the new group, and move it up until it exists in the world root (that is, outside of any other groups), as seen in Figure 4.25c. As you move the group over another object, two lines will appear above and below the object; these indicate that if you let go of the mouse now, the group will be placed within this object. If a single line appears, it indicates that letting go of the mouse button here will leave the group in the world root.

3 You know that you’ve included everything you need in group3, so you can now select the other bits and pieces as shown in Figure 4.25d and delete them.

Obviously, it’s very unlikely that the items in your Outliner will exactly match the ones in Figure 4.25, but this does not matter. In deciding what can be deleted, just look for items similar to the ones highlighted that are outside the group3 group.

4 You may also notice that a few new cameras have popped up (persp1 and persp2, for example) — the result of our having imported items earlier. Select and delete these. Do not delete the four main cameras (persp, top, front, and side), but feel free to remove any others.

5 Finally, rename group3 to Kila and save.

Modeling the Ear
So now we’ve finished off the hair. Our next step is to create an ear to place on the left side of Kila’s head.

TIP Before you start to model the ear, find a decent picture of an ear on the Internet or in an anatomy book. This will help you create an accurate model (or texture, depending on how the ear will be represented).
1 Start with a new scene, and create the cube in **Figure 4.26** using the following configuration: Width 0.5, Height 1.5, Depth 1, Subdivisions Along Width 1, Subdivisions Along Height 5, and Subdivisions Along Depth 2.

![Figure 4.26](image)

**Figure 4.26** Create a basic cube, five divisions high.

**Figure 4.27** Manipulate the cube until it resembles an ear.

2 Using your reference, shape the cube to achieve the basic shape of an ear. Work on it from the side and then the front, and finally in the perspective view until you are happy with it (**Figure 4.27**).

3 Before saving this version, remove some of the polygons from behind the ear, as seen in **Figure 4.28**.

![Figure 4.28](image)

**Figure 4.28** Remove the polygons from the back of the ear.

4 Delete the history and save this as Kila_Ear_01.mb, so you can use this version later if you choose.
We could quite happily use the ear in its present state, allowing the texture to show the detail—especially if we need to keep within our polygon budget. For the purposes of this tutorial, however, we will work on it a little more to show how to develop a more detailed ear in case we need one. Enhancing the ear is a simple case of cutting the details into the mesh using the Split Polygon tool, and then working on the geometry to achieve a satisfactory shape.

5 Divide the front of the ear, following the lines in Figure 4.29, left. Work on the entire front area until the ear is satisfactory (Figure 4.29, right). There is no need to put in every detail, since most of this can be achieved in the texture.

6 Delete the history and save this ear as Kila_Ear_02.mb.

Attaching the Ear

Now we have two ear models (one slightly more detailed than the other). For now, we are going to attach the higher-resolution version. When we come to optimize the mesh, we can reduce it if we need the polygons. Make sure you have both ears saved, and then load Kila_Hair.mb again.

1 Before you begin to attach the ear, you need to make the head whole. At the moment you only have one-half; the second, right side is simply an instance. Delete the instanced mesh and focus in on the head. It’s probably best to isolate the mesh, too, so you’re only working on the main body.
2 Select the faces shown in Figure 4.30 (the ones that make up the head and upper neck).

![Figure 4.30](image)

3 To separate these pieces from the main mesh, go to Edit Polygons > Extract and open up the options. Make sure Separate Extracted Faces is on, then click Extract. The head will now be separated from the rest of the body.

What we need to do now is duplicate this half, mirror it, and merge all the vertices down the center. There is a simple way to do this—use the Polygons > Mirror Geometry tool.

4 Open up the options for the Polygons > Mirror Geometry tool and, as seen in Figure 4.31, make sure –X is selected, as well as Merge With The Original and Merge Vertices. Click Mirror to apply the tool.

![Figure 4.31](image)
You should now have a full head with all the vertices welded nicely down the center; the last thing to do is smooth out the crease that runs down the middle of her head.

5 Import the ear we were working on earlier (Kila_Ear_02.mb) and position it as shown in Figure 4.32.

Looking at Figure 4.32, we seem to have miscalculated where the hair should be. We can adjust this now so that the hair lies over and behind the ear (Figure 4.32, right). Now that we know how the hair and ear should look, we can more capably work on this area. Hide the head at this stage so we can concentrate on the hair and ear.

6 As you can see in Figure 4.33 (left), one of the inner strips of hair is popping through the ear. Since this is quite close to the face, we can simply delete the entire strip by selecting its polygons and deleting them (Figure 4.33, right).

7 As illustrated in Figure 4.34 (left), rotate around so you are looking at the back of the ear from inside the head.

**TIP** Press F to focus the camera on the selected object or components.
8. Snap the two vertices belonging to the hair to the two nearest ones on the top of the ear. Then work your way around, splitting the hair as shown in Figure 4.34 (right) and leaving no gaps around the top and side of the ear.

9. Bring back the geometry for the head, and hide the hair. Before using the same vertex-snapping technique to fill in the gaps between the head and ear, you must first combine them. As demonstrated in Figure 4.35 (left), look from inside the head at the ear. Use the Append To Polygons tool to fill in the gap, making a seamless join between the head and the ear (Figure 4.35, right).
Work on the ear until the shape is satisfactory on all sides. For a start, you can collapse the edges at the front of the ear. These are highlighted in Figure 4.36 (left). Keep working until you achieve the model illustrated in Figure 4.36 (right).
As you can see in Figure 4.37, the outer head is now complete. All we need to do to finish it is test to see how it deforms, and optimize it—both of which we will cover in later chapters.

FIGURE 4.37 The outer head is complete.

Modeling the Eyes

If your game uses many real-time cut-scenes, chances are your character will need facial animation. The eyes play a huge part in acting; we are all drawn to the eyes when we interact with people.

Eyes are relatively easy to construct; all you need to do is create a sphere and optimize it slightly. You may have noticed that our model already has some spheres where the eyes should be. These were used earlier to create the eyelids, and we did not delete them. To demonstrate how to create the eyes, we will remove these spheres and start from scratch.

1. Create a new polygonal sphere with its Subdivisions Around Axis and Subdivisions Along Height both set to 8 (Figure 4.38a).

2. As demonstrated in Figure 4.38b, remove the back half of the sphere.
3 Select the edges that lie down the center of the sphere, shown in Figure 4.38c, and then collapse them to get the eye shape (Figure 4.38d).

4 Position this sphere so it lies where the left eye should be.

5 To create the right eye, duplicate the left eye mesh and alter the Translate X attribute in the Channel Box to be a negative value. For example, if it reads 0.38, make it –0.38.

There we have it; the eyes are done (Figure 4.39). Feel free to save at this point.
Developing the Inner Mouth

Cut-scenes can also involve conversation, so the inside of the mouth will need to be developed to include the teeth and a tongue. Let’s begin with her teeth.

The Teeth

Most games just adopt a simple set of teeth consisting of a flat curve of polygons with a teeth texture on them. This is what we will use for Kila—it’s unlikely that she would benefit from a set of fully modeled teeth because we will never get close enough to see them in detail. Besides, a full set of teeth would increase the polygon count dramatically.

1. In a new scene, create a new cylinder with the following configuration: Radius 1, Height 0.4, Subdivisions Around Axis 14, Subdivisions Along Height 1, and Subdivisions On Caps 1. Your cylinder should look like the one in the top panel of Figure 4.40.

2. Remove the top and bottom from the cylinder, as well as five quads from the back, giving you the shape in Figure 4.40 (bottom).

FIGURE 4.40 Create and edit a basic cylinder.
3 Teeth are never perfectly round, but at the moment our mesh is (Figure 4.41, left). Switch to the top view and scale the geometry to match the shape illustrated on the right in Figure 4.41.

![Figure 4.41](image)

**Figure 4.41** Scale the teeth geometry to achieve this shape.

4 We have our top teeth complete now. To create the bottom set, duplicate the upper set and position it below. Make sure you scale it in slightly along the X and Z axes, because a human’s bottom teeth are positioned back a little from the top teeth (Figure 4.42).

![Figure 4.42](image)

**Figure 4.42** Duplicate the top-teeth mesh and position it underneath and slightly back from the original set.

**The Tongue**

Now that the teeth are done, let’s create the tongue.

1 First hide the teeth; we don’t need them yet.

2 Create a cube with the following configuration: Width 0.5, Height 0.2, Depth 1, Subdivisions Along Width 2, Subdivisions Along Height 2, and Subdivisions Along Depth 3.
3. Following the progression in Figure 4.43, adjust the shape so it takes on the look of a tongue. Scale the upper and lower vertices in slightly in preparation for the next step, in which you will move the front-center ones out a little.

4. Select the vertices that lie down the center of the object and move them down a fraction, creating the crease in the tongue.

5. Rotate the front and the back to curve the tongue.

6. Make the teeth visible again and position the tongue inside them (Figure 4.44). You may need to scale the tongue further to make it fit properly. In addition, make sure you delete the faces at the rear of the tongue, as shown in Figure 4.44 on the right.

The teeth and tongue elements are complete, so delete the history and save as Kila_InnerMouth.mb.
**Adding the Inner Mouth Elements**
We will next merge the inner mouth elements we created (teeth and tongue) into our character.

1. Load in the last file you were working on (Kila_Hair.mb), and import the inner mouth elements into the scene.

2. Scale the geometry down and position it inside her head as shown in **Figure 4.45**. The upper teeth should just dip down below the bottom lip.

   ![Figure 4.45: Import the teeth and tongue into your latest scene and position them behind the lips.](image)

3. Double-check the shape of the mouth. If you can see teeth popping through, then the mouth is not the correct shape. Kila’s lips should lie on top of her teeth.

**The Inner Cheeks**
Before we finish the mouth area, we need to do one last thing. If Kila were to open her mouth in its current state, we would see not only her teeth and tongue but also the back of her head. On some platforms, we would not even see that—we would see straight through the back of her head. What’s needed now is to create the inside of the mouth, consisting of the top of the throat (upper palate) and inner cheeks.

1. At present, Kila’s lips are sealed shut, so to start you need to cut them open. As shown in **Figure 4.46** (top), focus in on her lips and select the vertices that run along the opening between the lips.
When you’re zooming into your geometry, it may happen that the camera cuts into the mesh before you get close enough. To fix this, open up the attributes for the camera by going to View > Camera Attribute Editor, and reduce the value for Near Clip Plane.

2 With the vertices selected, go to Edit Polygons > Split Vertex. This will split up the vertices, “un-welding” them, so to speak. Now the vertices are all separate. Select each one in turn and move it up or down, creating a slight opening in the mouth as shown in Figure 4.46 (bottom). Just remember to weld them again when you are done.

3 Hide the teeth and tongue for now. As illustrated in Figure 4.47, select the edges around the opening of the mouth.
4 Extrude the edges inward, adding two divisions to the extrusion (Figure 4.48a). Do this by setting Divisions to 3 for polyExtrudeEdge1 in the Channel Box.

5 Weld together all the vertices at the very end to create a point (Figure 4.48b).

6 Select the edges on both the top and the bottom of the extrusion, as highlighted in Figure 4.48c.

7 Collapse these edges (Figure 4.48d).

8 Bring the center points on the top upward, and the ones below downward, to create a hollow in the middle.

9 Optimize the shape by welding the extra vertices to the top and bottom points (Figure 4.48e).

FIGURE 4.48 Create the cavity of the mouth.
10 Adjust the vertices to make the cavity larger. Aim for the results shown in Figure 4.49.

![Figure 4.49](image)

**Figure 4.49** Enlarge the cavity to envelop the teeth and tongue.

11 Unhide the teeth and check to see that they fit inside the cavity.

We are now finished with the head area and can move on and add some clothing. But first, clean up your scene and save your work as Kila_Head.mb.

**Dressing Kila**

All game characters wear some sort of outfit—more often than not these will be weird and wonderful and will require extra polygons. In Kila’s case, we have some relatively simple additions to make. These include adding details to her crop top and jeans, as well as giving her a belt and a sash that drape her waist.

**Crop Top Details**

We’ll enhance Kila’s crop top and chest area by adding some cleavage, as well as a suggestion of a loose overhang at the waistline.

Start with the cleavage area. In the concept drawing, the low-neck top shows a bit of cleavage. What we need to do is define the neck of her crop top to implement this cleavage.

1 Using the Split Polygon tool, carve in the cuts shown in Figure 4.50 (right). These will allow us to edit the central area at the top of the cloth that bridges her breasts.
Modeling Details

FIGURE 4.50 Cut the polygons.

2 Smooth out the extra edges you have created—all except the ones that will mark the top of the fabric. These are highlighted in Figure 4.51 on the left.

3 Start working on the area, sculpting it to achieve the correct shape. You’re aiming for the result illustrated in Figure 4.51 on the right.

FIGURE 4.51 The cleavage, before and after

4 Move the vertices down the center first, pulling them inward, using the side view to line them up with the curve of her torso (Figure 4.52).

5 Continue working your way out, smoothing the area, moving downward the vertex just above the line of the fabric; this creates the crevice. Remember to convert joining triangles back to quads.
Notice in the concept drawing that the crop top is not skin tight, but rather is slightly loose at the bottom. We want to create this pointed “overhang.” As shown in Figure 4.53, we’ll focus in on the middle of her body.
1. Following the lines highlighted in Figure 4.54, cut around the center of the body. Mark out the base of Kila’s crop top, making sure that there are two parallel cuts encircling the entire body mesh.

   ![Figure 4.54](image)

   **Figure 4.54** Create two lines across her stomach, outlining the bottom of her crop top.

2. Scale the top line out and move it down, creating the overhang seen in Figure 4.55.

   ![Figure 4.55](image)

   **Figure 4.55** Create the overhang by moving the top line out and down.

3. When you created the initial cuts, some small edges will have been created; these in turn make up small polygons, like the ones in Figure 4.56 (top). It is best to get rid of these now, cleaning up the area.

   ![Figure 4.56](image)
4 Finally, spend some time smoothing out the general shape of the crop top (Figure 4.57).

With Kila's crop top completed, let's continue on down to the jeans, and the sash and belt that drape her waist.
Separating the Jeans from the Body

Our next clothing task is to model the character’s jeans. We could model the left side and mirror it to create the right, as we did with her upper body. Although this would save time, it would present a few problems. First, the sash around her waist cannot be mirrored; it should be built into the waist because it fits snugly at every point from the waist to the opposite hip. Also, we will be building creases into the legs of her jeans, so it would be very obvious if we simply mirrored one side to create the other.

Before we begin, we have to separate the jeans from the rest of Kila’s body, then create a duplicate to become the right side, and combine the sides as we did for her head.

1. Delete the mirrored instance if you have one, and select the polygons that will make up the jeans (Figure 4.58). This should be easy because you marked out the top of them earlier.

2. Go to Edit Polygons > Extract; this will separate the leg from the body. You should not have to open up the options and reconfigure them because they were saved the last time you used this tool.

3. Next, you need a mirrored duplicate, so go to Polygons > Mirror Geometry. Again, you set the options last time you used this tool, so they should be at the same settings now. You don’t have to open the options.

4. Since you only need to work on her legs at this point, it makes things easier if you hide the rest of the geometry. So select everything but the legs and press Ctrl+H/Cmd+H.

5. Double-check that the vertices down the center of the legs have merged correctly. If some have not, weld them now; smooth out the crease, too.
Now we have a complete pair of legs and we can begin working in the clothing details.

**Creating the Sash**

Because the sash fits snugly all the way around, we can simply mark in the outline so we’ll know where it will be on her form. It is made of thin material, so we don’t need to create an overhang as we did with the T-shirt. Our task with the sash is to work on the general area, smoothing it out and tidying it up.

Use the Split Polygon tool to mark in the outline for the sash. Follow the lines in Figure 4.59. I am sure your modeling skills are coming along wonderfully now, so I will leave this part up to you. Remember to remove any tiny polygons that have cropped up, and make the area as clean as possible. Your resulting mesh should resemble Figure 4.60.

![Figure 4.59 Mark in the outlines for the sash.](image)

To finish the sash, we will create a couple of folds in the fabric on the outside of the leg. We can rely on the texture to create most of the folds, but these at the thigh are quite distinct, so we will build them into the geometry.

![Figure 4.60 Tidy up the sash, removing unwanted polygons and creating smooth lines.](image)
1 Following Figure 4.61 as a guide, cut the polygons around the outside of her left thigh. You’ll need two cuts for each fold. Follow these cuts around the leg, spanning two polygons, matching the cuts on the front.

2 Select the vertices on the top of each cut and move them out, creating the upper part of the fold.

3 Finally move the lower vertices up slightly to close the gap (Figure 4.61, bottom).

Creating the Jeans
Continuing on to the jeans now, we first need to get some idea of the creases in the jeans at the back of her knees, and also on the lower legs. You should have some references for this already on your style sheet. Better still, use the original color concept image (Figure 4.62). You can find this on the CD: Project Files/01/ KilaColorRender.tif.

FIGURE 4.62 Use the color concept image as reference for the creases in the jeans.
Kila’s upper thigh area is relatively flat, so we don’t need to add any detail here. Like the folds on the sash, the creases in the jeans can be added when we apply texture. We can, however, build in some folds around the back of her knees. Move down to where her knees are; use the guide images to get the correct location.

1  As you did for the folds on the sash, cut the polygons here at the knees to create two segments (Figure 4.63, left).

2  Move the top of each segment out and the lower portion up, producing the two folds you can see in Figure 4.63, bottom. Because we combined the legs earlier, you will need to do this on each knee.

Moving around to the front of her legs, we will now build in some basic knees. These will function more toward deformation than for the overall look of the mesh.

3  Cut the polygons as shown in Figure 4.64. Then pull out the upper section in the middle of the knee, creating a ridge.
4 Adjust the overall knee areas, scaling them in slightly to get the correct shape (Figure 4.65).

Now we get to the lower legs. This area needs quite a bit of enhancement to achieve realistic creases and folds.

5 Following the progression in Figure 4.66, begin by creating a cut that will be the first fold in the jeans leg. Adjust the vertices around this first cut to fold the polygons at the front over the ones at the back. Move downward, adding in one fold at a time until you reach the bottom.
6  Rotating around to the back of the leg (Figure 4.67, left), you can see that not much needs to be added here—just a few creases at the bottom will do (Figure 4.67, right).

7  Follow these same procedures for the right jeans leg, adding the extra detail to the lower leg. You can see this progression in Figure 4.68.
When they’re finished, the legs of the jeans should look like Figure 4.69.

After all this work, unhide everything and see how she looks. Check out Figure 4.70, left. Her feet seem wrong. They are shaped oddly; plus they are pointing forward. We want them to be pointing out slightly, as real feet do naturally.

Work a little on the shoes until they look more realistic (Figure 4.70, right) and then rotate each foot so the toes are pointing out slightly. You will also need to rotate the bottom of the jeans to match the feet.
The Belt
The belt is relatively simple. It’s essentially just a cylinder that wraps diagonally around Kila’s hips.

1 Still in the same scene, create a cylinder with the following configuration: Radius 0.2, Height 0.05, Subdivisions Around Axis 14, Subdivisions Along Height 1, and Subdivisions On Caps 2.

2 As shown in Figure 4.71, delete the central polygons; then scale the remaining vertices out to create a small rim.

3 Position the cylinder as shown in Figure 4.72. Scale and rotate it until it just fits around her hip, draping diagonally.

![Figure 4.71](image1.png) Remove the center, and scale the remaining vertices out.

![Figure 4.72](image2.png) Position the cylinder at Kila’s hip, draping diagonally.
4  Working on the vertices, adjust the belt so it lies better (Figure 4.73).

![Figure 4.73 Adjust the belt to fit tighter around her hips.](image)

At the point where the belt slings downward, we can actually see the inside. The problem here is that once this goes into a game engine, you may be able to see right through the belt. Because the polygons on the belt are being displayed as double-sided, we are fooled into thinking it is solid. Let’s make it single-sided and see if we get an improvement.

5  Select the belt and press Ctrl+A to open up the object’s attributes (Figure 4.74).

![Figure 4.74 Open up the belt’s Attribute Editor.](image)
6 In the Render Stats pane, uncheck the Double Sided option; this will show you how the belt will look when it is displayed single-sided, as will happen in some platforms (Figure 4.75, left).

![Figure 4.75 Creating the inside of the lower belt](image)

7 Using the Append to Polygon tool, fill in the gaps on the inside of the belt (Figure 4.74, right)—but only do this at the base. The rest of the belt should lie quite close to the character’s body, so we don’t need to do the rest.

And there we have it; our model of Kila is complete! You can see the finished model in Figure 4.76.

You can clean her up as we did before, by deleting the history. In addition, at this point you can also freeze the transforms. This will reset all translate and rotate values to 0 and all scale values to 1, without losing any of the position, rotation, scale, or pivot alterations done to the mesh so far.

Save the file as Kila_Complete.mb.

Although we’re done working on this latest version of Kila, we have two more stages to go through before she can be signed off. In Chapter 5, we will examine optimization tasks, and in Chapter 6, we will look at deformation.
Summary
We now have a complete model of Kila, our main character. She has all the detail we need at the moment—but this also means we may have gone over our polygon budget. In the next chapter, we will examine areas where we can optimize, removing any geometry that is not needed.
Index

A
Add Attribute dialog box, 540–541
advertisements, 3
aim constraint, 577–580, 583–584
Alienbrain software, 26–27
alignment
texture, 399–400
vertices, 63
alpha maps, 415–426. See also transparency
described, 415
eyes, 419–424
hair, 415–419
texture details, 415–426
viewing in Maya, 417–419
wings, 424–426
anatomy, 19, 90, 776–778
animation. See also character rigging
archives, 760–763
blending, 713
categories, 712–714
cinematic, 713–714
clothing, 13
considerations, 13
custom, 713
cycle, 712
dividing, 711
Dope Sheet, 724–726
dynamic attributes, 521–522
facial. See facial animation
fidget, 712
fingers, 545–550
FK, 525–526
four-stage, 712–713
hair, 13, 589–590
idle, 712
IK, 525–530
manipulating, 760–763
mirroring, 711
optimization, 710–711
overview, 709–710
playblasts, 726–727
reference materials, 777
running in place, 759–760
sharing, 711
toes, 566–569
Trax Editor, 760–763
walk cycles, 710, 712, 727–759
wings, 589–590
animation controls, 716–717
animation curves, 719–724
animation list, 714–716
animation timeline, 717
animation tools, 716–727
Anisotropic material, 341
ankles, Grae, 565–566
ankles, Kila
deformation testing, 262–265
weight painting, 262–265, 672–673
Append to Polygon tool, 73
Arc tool, 577
arm pit area
adjusting vertices, 255
refining, 95, 120–121
welding, 71
arms, Grae. See also limbs
adding details to, 294–296
adding IK control, 538
adding muscles, 279–280
adjusting vertices on, 271
definition testing, 307–309, 318–319
extraction of, 339–340
joints, 307–310
optimizing, 305
positioning, 275
stitching to torso, 273
arms, Kila. See also limbs
altering pose, 446–451
animating, 752–759
biceps/triceps, 104–105
constraints, 532
controls, 531–538
definition testing, 240–256
detaching, 446–447
extending, 70
extraction of, 328–330
final rig adjustments, 686
joints, 240–256
left arm creation, 53–55
mapping adjustments, 376–378
muscles, 104–106
optimizing, 203–206
orientation of, 55
reattaching, 450–451
refining, 104–106
rotating, 448–450, 532
scaling, 70
skeleton, 240–243
skeleton binding, 243–244
UVs, 346–353
weight painting, 654–664
Art Renewal Center Web site, 778
artwork. See images
asymmetry, 17, 20
attributes
dynamic, 521–522, 540–545
images, 38
locking, 696–702
material, 341–345
nonkeyable, 696–702
Pitch, 547–548
slide view, 39–40
visibility, 699–701
audience, 3
automatic mapping, 326, 332
axis
resetting of, 44
rotational, 505–515
scaling around, 44
8
back muscles
Grae, 280–281
Kila, 96–98
backside, Grae, 282
Bake History option, 251
belt
creating, 195–198
mapping coordinates, 332
positioning, 195–196
reducing levels of detail, 472–473
UVs, 372–376
biceps, 104–105
binding
arms, Kila, 243–244
blend-shapes version, 652–653
character deformation and, 652–653
face, Kila, 608–611
face geometry, 653
joints, Grae, 311–321
wings, Grae, 311
binding pose, 446–454
biography, character, 6–11
bit depth, 436, 438–441
blend shapes
binding and, 652–653
facial animation, 604, 637–647
Grae, 648–649
Kila, 637–647
blending animations, 713
Blinn material, 341
body parts. See also limbs; specific body parts
attaching, 78–80, 142–145, 277
collection of, 87–88
detaching, 328–331, 337–339, 446–447
mirroring, 47–48
Morgue, xx, 87–88
muscle line mapping, 90–107
stitching together, 62–74
Bounding Box option, 45
brainstorm sheets, 19–21
branding considerations, 3
breasts, Kila. See also chest
adding, 81–87
bridging, 85
cleavage, 183–184
controls, 588–589
joint configurations, 500–502
position, 82
reducing size, 85–86
refining, 86
rotating, 82
weight painting, 679–680
welding to torso, 84
bump maps, 427–432, 766
buttocks, Kila, 101–103
C
calves, Kila, 211
cartoon characters, 18–19
CD-ROM, included with book, xix–xxi
Channel Control tool, 696–702
character deformation
binding, 652–653
final, Grae, 651–653, 691–692
final, Kila, 651–690
final rig adjustments, 685–686
preparation, 652–653
testing. See deformation testing
weight painting. See weight painting
character design, 1–23
animation issues, 13–14
brainstorm sheets, 19–21
branding, 3
character depth, 3
concepting, 4–23
considerations, 2–4, 16–19
early sketches, 19–21
game world, 3
importance of, 1
inspiration for, 3–4
overview, 16–23
player identification, 3
style sheets, 15–16
target audience, 3
technical considerations, 3
character rigging, 519–601. See also animation
arm/hand controls, 531–550
breast/chest controls, 588–589
curve tools, 524–525
described, 520
dynamic attributes, 521–522, 540–545
eye controls, 586–588
facial, 627–636
final adjustments, 685–686
finger controls, 540–550
forward kinematics, 525–526
Grae, fully rigged, 590
grouping controls, 591–592
hair controls, 589–590
head controls, 581–586
hip controls, 571–574
icons. See icons
inverse kinematics, 525–530
Kila, fully rigged, 590
leg/foot controls, 550–570
main body controls, 571–576
protecting, 696–702
spine controls, 571–574
tamper proofing, 696–702
upper body controls, 577
use of controls, 520–525
visibility controllers, 591–597
Waist controls, 571–576
Wing controls, 589–590
Wrist controls, 538–539
Character sets, 703–707
Character teams, xv–xvi
Characters
Anatomy, 19, 90, 776–778
Appeal of, 17
Biography, 6–11
Body parts collection, 87–88
Cartoon, 18–19
Changing size of, 37–40
Character sets for, 703–707
Clothing. See clothing
Color, 17
Combining geometry, 386–387
Contrast among, 17
Creating. See modeling
design of. See character design
Distortion, 13
Dividing, 327–340
Female, 17–18
Grae. See Grae model
Head sheets, 22–23
History, 6–11
Importance of, 1
Joint limits, 12
Kila. See Kila model
Limitations of, 3
Male, 17–18
Mirroring geometry, 386–387
Model sheets, 21–23
Muscle line mapping, 90–107
Personality of, 3
Placeholder, 41–50, 74–81
Polygon limits, 12–13
Preparations for, 15–16, 26–31
Proportions, 13, 17–19
renders, 20–21
Repositioning, 516–517
Researching, 5–14
Rest poses, 714–716
Rigging. See character rigging
Scale, 17–19
Silhouettes, 17, 22
Size of, 12–13, 17–19, 455–482
Style sheets for, 15–16
Success of, 2–4
Summary sheets, 20–21
Technical limitations, 11–14, 26
Third-person perspective, 13
Turnaround view, 22
Checker map technique, 340–378
Checkered textures, 340–378
Cheeks, Kila
Optimizing, 223, 225
Weights, 624–626
Chest, Grae, 278
Chest, Kila. See also breasts
Adding, 81–87
Controls, 588–589
Joint configurations, 500–502
Muscles, 94–96
Child objects, 47–48
Chin, Kila, 112, 119, 223–224
Clavicles, Kila
Animating, 752–759
Controls, 577–580
Rotations of, 531
Claws, Grae, 289–291
Cleanup process, 693–707
Clothing, 183–198
Animating, 13
Belt. See belt considerations, 13–15
Creases/folds in, 190–194, 211–213
Crop top T-shirt, 183–187, 382
Ideas for, 15
Jeans. See jeans
Sash, 189–190, 459–460
Shoes. See shoes
Collarbones
Grae, 278
Kila, 93–94
Color
Base, 394–396
Bit depth, 438–439
Characters, 17
Control icons, 598–600
Hair, 407
Multiplying, 394
Texture painting, 394–396
Color sheet, 26
Comics, as character inspiration, 4
Commands, repeating, 66
Component Editor, 658
Component mode, 46–47
Computer games. See games
Computer graphics, xv, 779
Concepting, 4–23
Connection Editor, 771–772
Constraints
Aim, 577–580, 583–584
IK, 570
Orient, 532
Pole vector, 529, 570
Control icons. See icons
Control Vertices (CV) Curve tool, 522–523
Controls. See character rigging
Creases
Adding to geometry, 100–101
In clothing, 190–194, 211–213
Creature Tools scripts, xix, 601
cropping neck, 75
cropping polygons, 72–73
crotch area, Kila, 99–101
cubes, tapering, 46
curves
Animation, 719–724
Edit points, 522–523
tools for, 522, 524–525
cuts
Mirrored instances and, 93
Unable to cut, 93
UV, 351–353
cylindrical mapping, 324–325, 330, 346–347
cylindrical shapes, 51


face, Grae. See also head, Grae; specific facial features adding details, 297–299 animating. See facial animation optimizing, 304 rigging, 648–649 face, Kila. See also head, Kila; specific facial features animating. See facial animation attaching, 653 binding, 608–611 blend shapes for, 637–647 creating, 107–120
Index

deformation testing, 265–268
details, 107–120
expressions, 265–268, 627–636
extracting, 637–639
joints, 604–626
muscle lines of, 112
optimizing, 221–229
reducing levels of detail, 464–465
refining, 117–120
rigging, 627–636
shapes, 639–647
subdividing, 108–109
texture details, 406–407
triangulation, 435

facial animation, 603–650
blend shapes, 637–647
considerations for, 649–650
Grae, 648–649
importance of, 604
joint-based, 604–626
Kila, 604–647
levels of detail and, 647
rig controls, 627–636, 648–649

facial expressions, 265–268, 627–636

facial rig, 627–636

feet, Grae
adding details, 289–291
animating, 710, 759
controls, 550, 565–570
rotating, 566
walk cycle, 710, 759

feet, Kila
animating, 730–747
controls, 551–565
creating, 145–149
deformation testing, 262–265
final rig adjustments, 685
joints, 551–553, 559–560
optimizing, 213–216
placeholders for, 81
positioning, 194
resolution, 145–146
reverse foot, 551
rotating, 552–553, 555, 562
twisting, 563, 569
UVs, 358–359
walk cycle, 710, 712, 727–759
weight painting, 262–265, 672–673

female characters, 17–18
files
names, 62
optimizing, 694–695
Photoshop, 395
project, xxi
saving, 62
size of, 694–695
Targa, 396

fingernails, Kila, 128–129, 230–231

fingers. See also hands
adjusting, 452–454
animating, 545–550
bending, 547, 664–666
controls, 540–550
creating, 125–134
Grae, 547, 691
merging, 141
optimizing, 233–235
pinkie, 546–549
quick poses, 540–545
reducing levels of detail, 458
rotating, 547
weight painting, 664–666

Flat Shade All option, 44–45
Flat Shade Selected Items option, 44–45
Flip Triangle Edge Tool, 69
forearms, Kila, 105
forums, 779
forward kinematics (FK), 525–526
freezing transforms, 44, 197

G

games
animating for. See animation
graphics and, xv
market for, xvii
Maya and, xvi
PlayStation, xvi, 4
Real Time CG site, 779
real-time strategy (RTS), 13

gameplay
control, 361

geometry
adding creases to, 100–101
binding, 653
breaking up, 327–334
combining, 386–387
duplicating, 48
face, 653
hardening, 101
linking, 653
mirroring, 171, 386–387
splitting up, 327–340
viewing, 44

Gimbal lock, 584–585

Google, 779

Grae model
adding details, 283–299
arms. See arms, Grae
biography, 10
blend shapes, 648–649
breaking up, 335–340
character history, 6–11
character set for, 707
claws, 289–291
collarbones, 278
deformation. See deformation testing, Grae
eyes. See eyes, Grae
early sketches, 20–21
face. See face, Grae
facial animation, 648–649
feet. See feet, Grae
final model, 321
fingers, 547, 691
hands. See hands, Grae
head. See head, Grae
joints. See joints, Grae
legs. See legs, Grae
levels of detail, 483
Grae model (continued)
limbs, 270–275
mapping, 387–388
modeling, 269–321
mouth. See mouth, Grae
muscle line mapping, 278–283
muscles. See muscles, Grae
neck, 276
optimizing, 303–306
renders, 20–21
setting binding pose, 446, 454
shoulders. See shoulders, Grae
skeletal structure, 496–498
technical limitations for, 14
teeth. See teeth, Grae
texture details, 414–415
texture effects, 427–431
texture preparation, 387–388
tongue, 299
torso. See torso, Grae
walk cycle for, 710, 759
weight painting, 691–692
wings. See wings

Graph Editor, 719–724
graphics, xv, 779
graphics cards, 766
graphics tablets, 780
grid options, 35
group node, 47–48
grouping items
controls, 591–592
objects, 47–48

groups
duplicating, 48
Level of Detail, 484–485

muscle, 90–107
gums, Grae, 298–299, 305

H

hair, Kila, 152–168
adding volume to, 159–161, 166
alpha map for, 415–419

optimizing, 230–235
placeholders for, 81
quick poses, 540–545
reducing levels of detail, 458, 465
resolution, 140–142
UVs, 371–372
weight painting, 664–666
hardening geometry, 101
head, Grae. See also face, Grae
attaching to body, 277
creating, 276–277
detaching from body, 338
optimizing, 304
head, Kila. See also face, Kila
attaching ears to, 170–174
attaching to body, 78–80
controls, 581–586
creating basic (primitive), 48–49
extraction of, 332–333
optimizing, 221–229
placeholders for, 74–80
rotating, 581
sculpting, 77
smoothing, 77
UVs, 360–365
weight painting, 673–676
head joint, 582–583, 674
head sheets, 22–23, 26, 107–108
heel joint, 555
highlights, 401–404
hips, Kila
animating, 731, 736–737, 741–745, 751
controls, 571–574
deformation testing, 258–261
joints, 258–261
weight painting, 258–261, 667–671

history
character, 6–11
deleting, 50, 61, 251, 616
horizontal sweep, 346
hotbox, 32–33
icons
benefits of, 521
breast, 588–589
color-coding, 598–600
creating, 522–525
default shapes for, 522
eye, 587
ready-made, 525
representing controls with, 521
visibility controls, 591–597
IK constraints, 570
IK handles, 527–530, 535–538, 590, 702
IK Rotate Plane solver, 527–529
IK Single Chain solver, 527–529, 582
IK solvers, 527–530, 582
IK Spline solver, 530
image planes, 30, 37–41, 131
images
attributes, 38
height of, 30
importing, 37–40
mirrored instance, 52, 80, 85
perspective view, 39
pieces of, 29–30
scaling, 28
scanned, 27–30
shrinking, 28
slide view attributes, 39–40
storing, 26–30
importing
head model sheet, 107–108
images to Maya, 37–40
instances, mirrored, 52, 80, 85, 93
instanceSplit.mel script, xx
interpolation, 719–724
inverse kinematics (IK), 525–530
Isolate Select command, 158
jaws
optimizing, 228
rotating vertices of, 640
weights, 612–618
jeans
creases/folds in, 190–194, 211–213
deformation, 673
details, 408–410
reducing levels of detail, 459–460
separating from body, 188–194
joint-based facial animation, 604–626
Joint tool, 488–490
joints
limits, 12, 488
number of, 488, 505
renaming, 310–311
rotational axis, 505–515
joints, Grae
binding, 311–321
creating, 307–310
eyes, 499–500
legs, 307–310
size of, 496
testing, 311–321
wings, 310–312, 503–504
joints, Kila
arms, 240–256
attaching meshes to, 243–244
chest, 500–502
creating, 488–490
eye, 244, 745–756
eyes, 499–500, 586–588
facial, 604–626
feet, 551–553, 560
hair, 502–503
head, 582–583, 674
legs, 257–265
options for, 488–490
paint weights, 244–250
spine, 571–574
wrists, 241, 756
K
Keep Faces Together option, 36, 71
keyboard shortcuts, 43, 47–48
keyframes
creating, 718–719
nonkeyable attributes and, 696–702
setting, 718–719
Kila model. See also specific body parts
arms. See arms, Kila
basic shape for, 51–87
binding, 608–611
biography, 10
breaking up geometry, 327–334
buttocks, 101–103
collar bones, 93–94
color-coded icons, 600
deformation. See deformation testing, Kila
eye history, 6–11
character history, 6–11
clothing set for, 703–707
collaboration, 93–94
creating, 51–87
clothing for. See clothing
collaboration
early sketches, 19–21
ears. See ears, Kila
eyes. See eyes, Kila
facial animation. See facial animation
facial features. See face, Kila
feet. See feet, Kila
final model, 51–87
fingers. See fingers
hair. See hair, Kila
hands. See hands, Kila
head. See head, Kila
head sheets, 22–23
joints. See joints, Kila
legs. See legs, Kila
levels of detail, 444–445
lips. See lips
mapping, 340–386
model sheets, 21–23
modeling. See modeling
mouth. See mouth, Kila
mouth
muscle line mapping, 90–107
Kila model (continued)

muscles. See muscles, Kila

neck. See neck, Kila

pelvis, 99–101

placeholder character for, 41–50

renders, 20–21

rest poses, 714–716

running in place, 759–760

setting binding pose, 446–454

shoulders. See shoulders, Kila

skeletal structure, 490–495

spine. See spine, Kila

technical limitations for, 14

Teeth. See teeth, Kila

texture details, 406–415

torque, 190–200

underscarfed, 40–41

upper body, 235–247

vertebral column, 490

wage painting, 654–684


knees, Grae

details, 285–287

rotating, 314–315

knees, Kila

controls, 554–556

deformation testing, 261–262

final rig adjustments, 685

joints, 261–262

optimizing, 210–211

weight painting, 261–262, 671–672

knuckles, 126–129, 139


Lambert material, 341–342

Lasso tool, 54

Layer Editor, 40–41

Layered Shader, 341

layers

editing, 40–41

hair, 153–156, 160–165

hiding everything in, 41

image planes, 40–41

shaders, 341

visibility of, 694

Learning Movies, 31–32

legs, Grae. See also limbs

adding details, 285–291

deformation testing, 312–315

extraction of, 335–336

joints, 307–310

lower, 285–287

muscles, 281–283

optimizing, 305–306

shaping, 272

stitching to torso, 274

weighting, 312–314

legs, Kila. See also limbs

animating, 730–747

controls, 550–570

deformation testing, 257–265

extraction of, 331

final rig adjustments, 685

joints, 257–265

left leg creation, 56–57

muscles, 106–107

optimizing, 210–213

skeleton, 257–258

UVs, 356–359

walk cycles, 730–747

weight painting, 258–265, 667–673

Level of Detail Group, 484–485

Levels of Detail (LODs), 443–517

150 polygon count, 479–482

500 polygon count, 474–479

1000 polygon count, 461–473

3000 polygon count, 455–460

facial animation and, 647

generating, 455–482

Grae, 483

Kila, 444–445, 455–482

number of, 444

polygon counts, 455–482

purpose of, 444–445

setting binding pose, 446–454

testing, 484–485

weights, 687–690

limbs. See also arms; body parts;

legs

basic creation, 42–47

basic shapes, 51–62

Grae, 270–275

mirroring, 47–48

pivot manipulator, 60–62

reducing levels of detail, 466–468

stitching together, 62–74

linking geometry, 653

lip-synching, 628, 631

lips

creating opening between, 180–181

Grae, 297

joints, 614–616

optimizing, 224

refining, 111–114, 119

smoothing, 224

weights, 614–616

locators, 448–450, 454, 522

LODs. See Levels of Detail

M

main menu bar, 32

male characters, 17–18

manipulators, 42–43

Manual directory, xix

mapping

automatic, 326, 332

cylindrical, 324–325, 330, 346–347

Grae, 387–388

Kila, 340–386

muscle line, Grae, 278–283

muscle line, Kila, 90–107

normal, 765–774

planar, 324–326, 329, 356

spherical, 325

textures, 324–327

UVs, 324–327, 340–383

marking menu, 32–33
Index

Marquardt Beauty Analysis Web site, 778
material attributes, 341–345
Maya
getting started in, 31–41
Learning Movies, 31–32
overview, xvi
Personal Learning Edition (PLE), xxi
preferences, 34–37
tutorials, 31–32
Web sites, 780
Maya/Scripts directory, xix–xx
measurement units, 34
memory, texture, 436, 438–441
menu sets, 32
menus, 32–33
meshes
attaching to joints, 243–244
combining objects into, 50
low-resolution, 53
mapping muscle groups onto, 90–107
mirPo tool, 545
Mirror Geometry tool, 171
mirrored instances, 52, 80, 85, 93
mirroring
animations, 711
gometry, 171, 386–387
limbs, 47–48
poses, 545
weights, 681–682
model sheets, 21–23, 26–28
modeling
body parts collection, 87–88
cleanup tasks, 49–50,
693–707
details, 151–198
final model, 51–87
getting started, 31–41
Grae, 269–294
Kila, 25–88
placeholder characters, 41–50
preparation for, 26–31
work environment, 27–31
working with scanned images, 27–31
models
cleanup, 49–50, 693–707
finalizing, 693–707
Grae. See Grae model
Kila. See Kila model
optimization. See optimization
scanning in, 27–28
size of, 455–482
Morgue, xx, 87–88
morph targets. See blend shapes
morphing, 637–647
mouth, Grae
adding details, 298–299
building, 298–299
creating cavity, 297
inner, 298–299, 304
optimizing, 304–305
mouth, Kila
adding teeth, 177–178
blend shapes, 639–641
creating, 111
facial expressions, 631–633
inner elements, 177–183,
364, 411–413
muscles, 114
refining, 111–114, 119
rig creation, 631–633
shape, 180, 628, 631–633,
639–641
texture details, 411–413
tongue, 178–179
UVs, 364
weights, 612–618
Move pivot point manipulator,
42–43
muscle line mapping
Grae, 278–283
Kila, 90–107
muscles, Grae
back, 280–281
legs, 281–283
stomach, 280–281, 284–285
muscles, Kila
arms, 104–106
back, 96–98
buttocks, 101–103
chest, 94–96
facial area, 112
legs, 106–107
mouth area, 114
neck, 92–93, 120–121
refining, 90–107
shoulders, 94–96
stomach, 98–99

N
nasal cavity, 118
nave, Kila, 123–124
navigation, menu, 32–33
neck, Grae, 276
neck, Kila
attaching to body, 78–80
controls, 580–581
creating basic (primitive),
48–49
cropping, 75
muscles, 92–93, 120–121
optimizing, 221–229
placeholders for, 74–80
refining, 120–121
weight painting, 673–676
normal mapping, 765–774
normals, 74, 77, 387, 765
nose, Kila
nasal cavity, 118
nostrils, 111, 118, 226–227
optimizing, 225–227
refining, 110–111, 117–118
nostrils, 111, 118, 226–227
notePad.mel script, xx

O
Object mode, 46–47
objects, 44–50
optimization, 199–238
animation, 710–711
arm, 203–206
creases/folds in clothing,
211–213
face, 221–229
foot, 213–216
fully optimized model,
236–238
Index (continued)

optimization
Grae, 303–306
hair, 216–220
hand, 230–235
head, 221–229
legs, 210–213
neck, 221–229
overview, 199–200
scenes, 694–695
torso, 206–208
waist, 208–209
Optimize Scene Size tool, 694–695
orient constraint, 532
Outliner, 49–50, 167–168, 701

Paint Skin Weights tool, 612–614
painting
texture. See texture painting
weights. See weight painting
palm, Kila, 136–138
parent objects, 47–48
pelvis, Kila, 99–101
Pencil Curve tool, 522
perspective view, 39
Phong/Phong E materials, 341
Photoshop, 392
Pitch attributes, 547–548
pivot manipulator, 60–62
pivot point manipulator, 42–43
pivot points
manipulating, 42–43
moving, 60–62
spine, 572–575
placeholder characters, 41–50, 74–81
planar mapping, 324–326, 329, 356
Playback Controls, 716–717
playblasts, 726–727
PlayStation games, xvi, 4
Plug-In Manager, 766–767
plug-ins, 766–767, 780
Points option, 45
pole vector, 527–529
pole vector constraint, 529, 570
Polycount Web site, 779
polygon count
100 polygons, 479–482
500 polygons, 474–479
1000 polygons, 461–473
3000 polygons, 455–460
character model comparison, 229–230
determining, 202–203
limits, 12–13, 200, 230
showing, 202–203
polygon faces
adding, 65–67
deleting, 67
internal, 79
keeping together, 36, 71
removing, 64
splitting, 68
polygon planes, 767–769
polygon sphere options, 82
polygons
creating, 65
cropping, 72–73
Keep Faces Together option, 36, 71
number of. See polygon count
reducing number of, 200–201, 433–434
removing from geometry, 200–201
shallow angles, 200–201
splitting, 99
unnecessary, 200
Posing Guide Web site, 778
preferences, 34–37
primitives, 41–50
project files, xxi
projects, 35–37
.psd (Photoshop) files, 395

Q
quads, 121–122

R
Range Slider, 716–717
RayDisplace plug-in, 766
Real Time CG Web site, 779
real-time strategy (RTS) game, 13
reference materials, 775–780
renders, 20–21, 270
resBatch.mel script, xx
research, 5–14
resolution
feet, 145–146
hands, 140–142
meshes, 53
normal maps and, 767–769, 771
scanned images, 28–29
resources, 775–780
rigs/rigging. See character rigging
Rotate pivot point manipulator, 42–43
rotation
arms, 532
breasts, 82
feet, 552–553, 555, 562, 566
fingers, 547
gimbal lock problems, 584–585
head, 581
knees, 314–315
shoulder, 531, 533
vertices, 55
rotation order, 584–585
rotational axes, 505–515
rotational pivot, Grae, 318
RTS (real-time strategy) game, 13
running in place, 759–760
sash
creating, 189–190
reducing levels of detail, 459–460
Save Selected command, 695
saving items, 62, 695
Scale pivot point manipulator, 42–43
scaling
arms, 70
images, 28
object axis and, 44
UVs, 380
vertices, 54
scanned images, 27–30
scenes
cleanup, 49–50, 694–695
optimizing, 694–695
viewing in Outliner, 49–50
scripts, xix–xx, 601, 780
Scripts directory, xix
selection field, 702
selection handles, 520–521, 534
selections
isolating, 158
shortcut keys, 48
vertices, 54
Set Driven Key dialog box, 629
Set Driven Keys, 542–544, 546
shaders, 341, 396–397
shadows, 404–405
shallow angles, 200–201
sharing items, 711
shelves, Maya, xx
shoes
creating, 141
details, 194
extraction of, 331–332
optimizing, 213–215
positioning, 194
reducing levels of detail, 472–473
UVs, 358–359
shortcut keys, 43, 47–48
shoulders, Grae
adding muscles, 279–280
deformation testing, 309, 316–317
smoothing out, 284
weighting, 316–317
shoulders, Kila
animating, 748–749, 752–757
deformation testing, 254–256
joints, 241
muscles, 94–96
optimizing, 215
rotation, 531, 533
weight painting, 254–256, 654–661
welding, 71–72
showMaterial.mel script, xx
skirts, early, 19–21
sketches, 15–16
styles, characters, 16–17
subdivision surfaces, 53
summary sheets, 20–21
symmetry, 17, 20
system requirements, 766
tangents, 719–724
Targa files, 396
target audience, 3
tattoo
adding, 411
mapping adjustments, 376–378
UVs and, 355
technical limitations/restrictions, 11–14, 26
teeth, Grae
adding details, 298–299
building, 298–299
detachment of, 338–339
optimizing, 305
teeth, Kila
adding, 177–178
fitting inside mouth cavity, 183
positioning tongue between, 179
texture details, 412–413
UVs, 364
testing. See deformation testing
texture details
alpha maps, 415–426
Grae, 414–415
Kila, 406–415
texture effects
Grae, 427–431
Kila, 432
texture memory, 436, 438–441
texture pages
creating base for, 384–386
rearranging UVs into, 380–381
reducing size of, 436–437
size of, 381, 394
texture painting, 391–441
base colors, 394–396
bit depth, 436, 438–441
bump/specularity maps, 427–432
darker shades, 401–404
final texture details, 406–415
highlights, 401–404
image preparation, 393–394
lighter shades, 401–404
page size reduction, 436–437
Photoshop, 392
polygon reduction, 433–434
shadows, 404–405
topology check, 433–435
triangulation, 434–435
texture preparation, 323–389
checkered textures, 340–378
dividing characters, 327–340
exporting UV positions, 379–387
mapping Grae, 387–388
mapping methods, 324–327
mapping UVs, 340–378
textures
alignment, 399–400
applying, 396–398
checkered, 340–378
viewing in Maya, 396–400
thighs, Kila
optimizing, 210
weight painting, 668–671
thumbs, 132–135
Time Slider, 611–612, 716–718
toes
Grae, 289–291, 566–569
Kila, 556, 559–563
tongue
adding control to, 616–618
Grae, 299
Kila, 178–179
positioning between teeth, 179
weights, 616–618
torso, Grae
adding muscles, 280–281
adjusting vertices, 271
creating, 270
detaching body parts from, 337–339
shape of, 271–272
stitching arms/legs to, 273–274
torso, Kila
animating, 747–752
basic shapes, 51–62
creating, 57–58
creating basic (primitive), 48–49
deleting half of, 59–60
optimizing, 206–208
positioning, 57–58
reducing for levels of detail, 468–472
removing arms from, 328–330
removing legs from, 331
UVs, 353–356
weight painting, 676–680
welding breasts to, 84
TransferSurfaceInfo.mll plug-in, 766–767
transforms, freezing, 44, 197
transparency, 415–426. See also alpha maps
Trax Editor, 760–763
triangles
converting to quads, 122
flipping edges of, 69
removing, 94
texture painting, 434–435
triangulation, 434–435
triceps, 104
tutorials, 31–32, 780
U
undo operation, 226
units of measurement, 34
UV layouts, 381
UV sewing, 350–351
UV snapshots, 383–386
UV Texture Editor, 347–354
UVs
cutting, 351–353
described, 323
exporting positions, 379–388
management of, 379–382
mapping, 324–327, 340–383
moving, 351–353
scaling, 380
snapshots, 383–386
V
vertices
adding, 68
alignment, 63
editing, 46–47
merging, 63
rotating, 55
scaling, 54
selecting, 54
welding, 63–64, 66
working with, 46
video cards, 766
viewing modes, 241
views
alpha maps, 417–419
geometry, 44
perspective, 39
slide, 39–40
switching, 37
textures, 396–400
turnaround, 22
visibility attribute, 699–701
visibility controllers, 591–597
visual styles, 16–17
W

waist, Kila
  animating, 730–747
  controls, 575–576
  optimizing, 208–209
  texture details, 408
  UVs, 356–359
  walk cycle, 730–747
  weight painting, 667, 670
walk cycle, 710, 712, 727–759
Web Gallery of Art Web site, 778
Web sites
  anatomy references, 777–778
  computer graphics, 779
  Maya sites, 780
  resources, 777–780
weight painting
  arms, 654–664
  breasts, 679–680
  described, 244
  elbows, 244–250, 661–662
  Grae, 312–314, 691–692
  Grae fully weighted, 692
  hair, 674–675, 680
  hands, 664–666
  head, 673–676
  Kila, 654–684
  Kila, fully weighted, 690
  legs, 312–314, 667–673
  lower torso, 258–265
  mirroring weights, 681–682
  neck, 673–676
  shoulders, 254–256
  torso, 676–680
  waist, 667, 670
  wrists, 662–664
weights
  copying, 687–689
  joints, 611–626
  level of detail, 687–690
  mirroring, 681–682
wings, Grae
  alpha map for, 424–426
  animating, 589–590, 759
  basic geometry, 301
  binding, 311
  controls, 589–590
deformation testing, 311–312
deforming, 310
extraction of, 335
finger joints on, 691
joints, 310–312, 503–504
modeling, 300–302
movement of, 503–504
texture in, 424–426
weight painting, 691–692
Wireframe on Shaded option, 45
Wireframe option, 44–45
working environment, 27–31
wrists, Kila
  animating, 756
  controls, 538–539
  joints, 241, 756
  optimizing, 230–232
  weight painting, 662–664
X
X-Ray mode, 45
X-Ray option, 45